
Chapter 5

Creating Reference
Geometries

After completing this chapter you will be able to:
• Create reference plane.
• Create reference axis.
• Create reference coordinate system.
• Create model using other Boss/Base options.
• Create model using the contour selection technique.
• Create a cut feature.
• Create multiple disjoint bodies.

Learning Objectives

c05-solidworks-2003.p65 5/12/2003, 10:13 AM1



5-2             SolidWorks for Designers

Figure 5-1  A multifeatured model

IMPORTANCE OF THE SKETCHING PLANES
In the previous chapter you created the basic models by extruding or revolving the sketches.
All of these models were created on a single sketching plane, the Front plane. But most of the
mechanical designs consist of various features such as the sketched features, referenced
geometries, and placed features. These features are integrated together to complete a model.
Most of these features lie on different planes. When you open a new SolidWorks document
and enter the sketching environment and create a sketch, the sketch is created on the default
plane, which is the Front plane. This is because the Front plane is selected by default when
you enter the sketching environment. You can also create the base feature on a plane other
than the default plane. To create additional features, you need to select an existing plane, or
a planar surface, or you have to create a plane that will be used as a sketching plane to create
the sketch. Consider the model shown in Figure 5-1, which is created using various features.

The base feature of this model is shown in Figure 5-2. The sketch for the base feature is
drawn on the Top plane. After creating the base feature you will have to create the other
features, which include sketched features, placed features, and referenced features, see
Figure 5-3. The boss features, and cut features, are the sketched features that require sketching
planes where you can draw the sketch of the features.

It is evident from Figure 5-3 that the features added to the base feature are not created on the
same plane on which the sketch for the base feature is created. Therefore, to draw the sketches
of other sketched features you will need to define other sketching planes.

REFERENCE GEOMETRY
The reference geometry features are the features that consist of no mass and no volume.
These are available only to assist you in the creation of the models. They act as a reference for
drawing the sketches for features, defining the sketch plane, assembling the components,
references for various placed features and sketched features, and so on. The reference geometry
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is widely used in creating complex models; therefore, one must have a good understanding
of reference geometry. In SolidWorks reference geometry exists as reference planes or planes,
reference axis, and reference coordinate system.

Reference Planes
Generally, all the engineering components or designs are multi- featured models. Also, as
discussed earlier, all the features of a model are not created on the same plane on which the
base feature is created. Therefore, you have to select one of the default planes or create a new
plane that will be used as the sketching plane for the second feature. It is clear from the
above discussion that either you can use the default planes as the sketching plane or you can
create a plane that can be used as a sketching plane. The default planes and the creation of a
new plane are discussed next.

Figure 5-2  Base feature for the model

Figure 5-3  Model after adding other features
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Tip. You can display the default planes in the drawing area using the following
procedure:

Press and hold the CTRL key from the keyboard and one by one select the Front,
Top, and the Right planes from the FeatureManager Design Tree. Right-click
to display the shortcut menu and choose the Show option from this shortcut menu
to display the planes in the drawing area. Choose the Isometric button from the
Standard Views toolbar. The default planes are transparent and the boundary of
the planes is displayed in gray color. Generally, it is not recommended that you
display the planes because sometimes may interfere while selecting entities.

To display the shaded planes, choose Tools > Options from the menu bar to invoke
the System Options - General dialog box. Choose the Display/Selection option
from the left of this dialog box; the name of the dialog box will be displayed as the
System Options - Display/Selection dialog box. Select the Display shaded
planes check box from this dialog box and choose the OK button.

After displaying the planes in shaded form, invoke the Rotate View tool and drag
the Rotate view cursor to rotate the shaded planes. You will observe that one side of
the plane is displayed in green color and the other side of the plane is displayed in
red color. The green side of the plane symbolizes the positive side and the red side of
the plane symbolizes the negative side. This means that when you create a extrude
feature, the depth of extrusion will be assigned to the positive side of the plane by
default. When you create a cut feature the depth of the cut feature is assigned to the
negative direction by default.

Default Planes
When you create a new SolidWorks part document, SolidWorks provides you with three default
planes. These there planes are

1. Front plane
2. Top plane
3. Right plane

The orientation of the component depends on the sketch of the base feature. Therefore, it is
recommended that you carefully select the sketching plane for creating the sketch for the
base feature. The sketch plane for drawing the sketch of the base feature can be one of the
three datum planes provided by default. If you invoke the sketcher environment without
selecting any sketching plane, the sketch is created on the Front plane by default. You can
select the sketching planes before invoking the sketcher environment from the
FeatureManager Design Tree available on the left of the graphics screen. The FeatureManager
Design Tree with three default planes is displayed in Figure 5-4.

When you work in Assembly mode of SolidWorks, you will also find three default assembly
planes. The default assembly planes will be discussed in the later chapters.
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Tip. When you have to create any multifeatured solid model, first try to visualize
the number of features in that model and then decide which feature in the model
can be considered as the base feature.

Figure 5-4  FeatureManager
Design Tree with default planes

Creating New Planes

Reference planes or planes are used to draw sketches for the sketched features. These
planes are also used to create a placed feature like holes, reference an entity or a
feature, and so on. The plane can also be selected to draw the sketch for a sketched

feature and these planes are known as sketch planes. You can also select a planar face of a
feature that will be used as a sketching plane. Generally, it is recommended that you use the
planar faces of the features as the sketching planes. However, sometimes you have to create a
sketch at a plane that is at some offset distance from a plane or a planar face. In this case you
have to create a new plane at an offset distance from a sketching plane or a planar face.

Consider another case where you have to define a sketching plane tangent to a cylindrical
face of a shaft. You have to create a plane tangent to the cylindrical face of the shaft and this
plane will be used as a sketching plane. In SolidWorks, there are six method to create planes.
Choose the Plane button from the Reference Geometry toolbar to invoke the Plane
PropertyManager. The confirmation corner is also displayed at the top right corner of the
drawing area. The Plane PropertyManager is  displayed in Figure 5-5. Various options available
in the Plane PropertyManager to create new planes are discussed next.

Creating a Plane Using Through Lines/Points
The Through Lines/Points option is used to create a plane that passes through an edge
and a point, an axis and a point, or a sketch line and a point. Using this option you can
also create a plane that passes through three points. The selected point can be a sketched
point or a vertex. To create a plane using this option, invoke the Plane PropertyManager
and choose the Through Lines/Points button and select the required entities from the
drawing area. The name of the selected entities will be displayed in the Reference Entities

Toolbar: Reference Geometry > Plane
Menu: Insert > Reference Geometry > Plane
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Figure 5-5  Plane PropertyManager

selection list. Choose the OK button from the Plane PropertyManager. Figure 5-6 shows
an edge and a vertex selected to create a plane. The resultant plane is displayed in
Figure 5-7. The creation of a new plane by selecting three points is displayed in
Figures 5-8 and 5-9.

Creating a Plane Parallel to an Existing Plane or Planar Face
The Parallel Plane option is used to create a plane that is parallel to another plane or a
planar surface and passes through a point. To create a plane using this option, invoke the

Figure 5-6  Selecting the edge and vertex Figure 5-7  Resultant plane
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Figure 5-8  Selecting the vertices Figure 5-9  Resultant plane

Plane PropertyManager and then choose the Parallel Plane button from this
PropertyManager. Now, select the plane or a planar face to which the newly created
plane will be parallel. Then select a sketched point or midpoint of an edge. The newly
created plane will pass through this point. Choose the OK option. Figure 5-10 shows a
planar face and the point selected to create the parallel plane. Figure 5-11 shows the
resultant plane.

Creating a Plane at an Angle to an Existing Plane or a Planar Face
The At Angle option is used to create a plane at an angle to the selected plane or a
planar face and passes through an edge, axis, or sketched line. To create a plane at an
angle, choose the At Angle button from the Plane PropertyManager. The Angle spinner
is invoked. The Reverse direction check box and Number of Plane to Create spinner
appear below the Distance spinner in the Plane PropertyManager as shown in
Figure 5-12. Now, using the left mouse button select an edge, an axis, or a sketched line
through which the plane will pass. Next, you have to select a planar face or a plane to
define the angle. Now, set the angle value using the Angle spinner. You can reverse the
direction of plane creation by selecting the Reverse direction check box. You can also

Figure 5-10  Selecting the planar face and edge Figure 5-11  Resultant plane
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Figure 5-13  Selecting the edge and the planar face Figure 5-14  Resultant plane

Figure 5-12  Plane PropertyManager with At Angle option selected

create multiple planes by increasing the value of the Number of Planes to Create spinner.
Figure 5-13 shows a planar face and edge selected. Figure 5-14 shows the resultant plane
created at an angle of 45º to the selected plane.

Creating a Plane Using Offset Distance
The Offset Distance option is used to create a plane at an offset distance from a selected
plane or planar face. To create a plane using this option, choose the Offset Distance
button from the Plane PropertyManager. When you invoke this option, the Distance
spinner is invoked. Also, the Reverse direction check box and the Number of Planes to
Create spinner are displayed below the Distance spinner in the Plane PropertyManager.
Select a plane or a planar face and set the value of distance in the Distance spinner and
choose the OK button from the Planar PropertyManager. You can reverse the direction
of plane creation by selecting the Reverse direction check box. You can also create multiple
planes by increasing the value of the Number of Planes to Create spinner. Figure 5-15
shows a plane selected to create parallel plane and Figure 5-16 shows the resultant plane
created at the required offset.
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Figure 5-15  Selecting the plane Figure 5-16  Resultant plane

Creating a Plane Normal to Curve
This option is used to create a plane normal to a curve. To create a plane normal to a
curve, choose the Normal to Curve button from the Plane PropertyManager. When you
choose the Normal to Curve button, the Set origin on curve check box is displayed.
Now, select a curve such as a sketched arc, circle, spline, or circular edge. As soon as you
select the curve, the preview of the plane is displayed in the drawing area. Choose the
OK button from the Plane PropertyManager or choose the OK icon from the confirmation
corner. Figure 5-17 shows a curve to create the plane. The Set origin on curve check box
is selected to place the origin on curve. By default, this check box is clear. Figure 5-18
shows the resultant plane created normal to the selected curve.

Note
 If you select the curve near the first endpoint to create a plane normal to the curve, the plane
will be created at the first endpoint of the curve. If you select the curve near the second endpoint,
the plane will be created normal to that curve near the second endpoint.

Tip. You can also create the planes by dynamically dragging an existing plane. For
creating a plane by dragging, you do not need to invoke the Plane
PropertyManager. Using the left mouse button select the plane from the Feature
Manager Design Tree or Drawing area. Press and hold down the CTRL key on
the keyboard. Now, move the cursor to the selected plane and when the cursor is
replaced by the move cursor, press and hold down the left mouse button and drag
the cursor. You will notice that the value of distance in the Distance spinner of the
Plane PropertyManager will modify and the preview of the plane is displayed in
the drawing area. After dragging the plane to a required location release the left
mouse button. Right-click and choose the OK option or choose the OK button from
the Plane PropertyManager.

You can also create a plane at an angle by dragging. To create a plane at an  angle
by dragging, select an edge or an axis and an existing plane. Now, hold the CTRL
key and drag the mouse. Enter the angle value in the Angle spinner.
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Figure 5-17  Edge to be selected Figure 5-18  Resultant plane

Creating a Plane On Surface
The On Surface option is used to create a plane passing through a point on the selected
plane or planar surface. To create a plane on surface, choose the On Surface button from
the Plane PropertyManager and select the surface on which you want to create the
plane. Next, select the sketched point. The preview of the plane is displayed in the
drawing area and you have to right-click to choose the OK option. If the sketch is created
on a plane at an offset distance from the selected surface, the Project to nearest location
on surface and Project onto surface along sketch normal radio buttons, and the Other
Solutions button are displayed on the Plane PropertyManager. Select any of the radio
buttons according to requirement. You can also view the other solutions of the plane
creation using the Other Solutions button from the Plane PropertyManager. Figure 5-19
shows the selection of references for the plane creation and Figure 5-20 shows the resultant
plane created.

Figure 5-19  References to be selected Figure 5-20  Resultant plane
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Creating Reference Axis

The Reference Axis option is used to create a reference axis or construction axis.
These axis are the parametric lines passing through a model, feature, or reference
entity. A reference axis is used to create reference planes, coordinate systems, circular

patterns, and for applying mates in the assembly. These are also used as reference while
sketching, or creating features. The reference axes are displayed in the model as well as in
the Feature Manager Design Tree. When you create a circular feature, a temporary axis is
automatically created. You can display the temporary axis by choosing View > Temporary
Axis from the menu bar. In SolidWorks you have to invoke the Reference Axis dialog box to
create the reference axis. You can invoke the Reference Axis dialog box using the Axis
button from the Reference Geometry toolbar or by choosing Insert > Reference Geometry
> Axis from the menu bar. The Reference Axis dialog box is displayed in Figure 5-21. The
various options available in this dialog box are discussed next.

Creating a Reference Axis Using One Line/Edge/Axis
The One Line/Edge/Axis option available in the Defined by area of the Reference Axis
dialog box is used to create a reference axis by selecting a sketched line or construction line,
edge, or temporary axis. To use this option, invoke the Reference Axis dialog box; the One
Line/Edge/Axis radio button is selected by default. Select a sketched line, edge, or a temporary
axis. The name of the selected entity is displayed in the Selected items display area and the
preview of the reference axis is displayed in the drawing area. Now, choose the OK button
from the Reference Axis dialog box. Figure 5-22 shows a construction line selected as a
reference for creating the axis. Figure 5-23 shows an axis created using this option.

Toolbar: Reference Geometry > Axis
Menu: Insert > Reference Geometry > Axis

Figure 5-21  The Reference Axis dialog box

Tip. If the axis is not displayed in the drawing area, choose View > Axes from the
menu bar.
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Figure 5-22  Line to be selected Figure 5-23  Resultant reference axis

Creating a Reference Axis Using Two Planes
Using the Two Planes option you can create a reference axis at the intersection of two planes.
To create a reference axis using this option, invoke the Reference Axis dialog box. Select the
Two Planes option and then select two planes, two planar faces, or a plane and a planar face.
The preview of the axis is displayed in the drawing area. Choose the OK button from the
Reference Axis dialog box. Figure 5-24 shows two planes selected and Figure 5-25 shows the
resultant reference axis created using this option.

Creating a Reference Axis Using Two Points/Vertex
Using the Two Points/Vertex you can create a reference axis that passes through two points
or two vertices. To create a reference axis using this option, invoke the Reference Axis dialog
box. Select the Two Points/Vertex radio button from this dialog box and then select two
points or two vertices using the left mouse button. The preview of the reference axis is displayed
in the drawing area. Choose the OK button from the Reference Axis dialog box. Figure 5-26
shows two vertices to be selected and Figure 5-27 shows the resultant reference axis created
using this option.

Figure 5-24  Planes to be selected Figure 5-25  Resultant reference axis
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Figure 5-26  Vertices to be selected Figure 5-27  Resultant reference axis

Creating a Reference Axis Using Cylindrical/Conical Surface
Using the Cylindrical/Conical Surface option you can create a reference axis that passes
through the center point of a cylindrical or a conical surface. To create a reference axis using
this option, invoke the Reference Axis dialog box. Select the Cylindrical/Conical Surface
radio button from this dialog box. Select the cylindrical or the conical surface using the left
mouse button. The preview of the reference axis is displayed in the drawing area. Choose the
OK button from the Reference Axis dialog box. Figure 5-28 shows a cylindrical surface
selected and Figure 5-29 shows the resultant reference axis created using this option.

Creating a Reference Axis Using Point and Surface
Using the Point and Surface option you can create a reference axis that passes through a
point and is normal to the selected surface. If the selected surface is a nonplanar surface, the
selected point should be created on the surface. To create a reference axis using this option,
invoke the Reference Axis dialog box. Select the Point and Surface radio button from this
dialog box. Now, select a point, vertex, or midpoint and then select a surface. The preview of
the axis will be displayed in the drawing area. Choose the OK button from the Reference
Axis dialog box. The newly created axis will be normal to the selected surface. Figure 5-30

Figure 5-28  Cylindrical surface to be selected Figure 5-29  Resultant reference axis
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shows the point and surface selected and Figure 5-31 shows the resultant axis created using
this option.

Creating Reference Coordinate System

In SolidWorks you may need to define some reference coordinate systems other than
the default coordinate system for creating features, analyzing the geometry, analyzing
the assemblies, and so on. The Coordinate System dialog box is used to create the

reference coordinate systems. You can invoke this dialog box using the Reference Axis button
from the Reference Geometry tool bar or by choosing Insert > Reference Geometry >
Coordinate System from the menu bar. The Coordinate System dialog box is shown in
Figure 5-32.

As soon as you invoke this dialog box a coordinate system in red color is displayed at the
origin of the current document. For creating a new coordinate system you need to select a
point that will be selected as the origin for the new coordinate. Therefore, after invoking this

Figure 5-30  Point and surface to be selected Figure 5-31  Resultant reference axis

Toolbar: Reference Geometry > Coordinate System
Menu: Insert > Reference Geometry > Coordinate System

Figure 5-32  The Coordinate System dialog box
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dialog box, select a point, vertex, or endpoint to define the origin of the coordinate system.
The name of the selected entity will be displayed below the Origin display area. You will also
observe that the coordinate system  displayed in red color at the origin will be shifted to the
newly selected point. If the default orientation of the coordinate system is according to the
requirement, choose the OK button from the Coordinate System dialog box.

You can also select the edges, points, axis, and so on to define the X, Y, and Z directions. To
define the X direction, select the X Axis display area in the dialog box. It changes to red
color. Now, select the edge, axis, vertex, or point to define the direction of the X axis. Using
the Flip check box available under the X Axis display area, you can reverse the X direction.
Similarly, you can define Y and Z directions. After defining all the references, choose the OK
button from the Coordinate System dialog box. Figure 5-33 displays a reference coordinate
system created using the Coordinate System dialog box.

OTHER BOSS/BASE OPTIONS
Some of the boss/base extrusion options were discussed in previous chapters. In this chapter,
the remaining boss/base extrusion option are discussed.

End Condition
The various options available in the End Condition drop-down list are discussed next.

Through All
The Through All option is available in the End condition drop-down list only after you
create a base feature. After creating a base feature, select or create a plane and choose the
Sketch button from the Sketch toolbar. The sketching environment is invoked. Create the
sketch using the standard sketching tools. Now, choose the Extruded Boss/Base button from
the Features toolbar to invoke the Extrude PropertyManager. The confirmation corner is
also displayed. The preview of the extruded feature is displayed in temporary graphics in the

Figure 5-33  A coordinate system created using the Coordinate System dialog
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drawing area with Blind option selected by default in the End Condition drop-down list.
Select the Through All option from the End Condition drop-down list and the preview of
the extruded feature extends from the sketching plane through all existing geometric entities.
You can also reverse the direction of extrusion using the Reverse Direction button available
on the left of the End Condition drop-down list. While creating an extruded feature using
the Through All option, the sketch extrudes through all the existing geometries. You will
observe that the Merge result check box is displayed in the Extrude PropertyManager. This
check box is selected by default. Therefore, the newly created extruded feature will merge
with the base feature. If you clear this check box, this extruded feature will not merge with
the existing base feature, resulting in the creation of another body. The creation of a new
body can be confirmed by observing the Solid Bodies folder in the Feature Manager Design
Tree. The value of the number of disjoint bodies in the model is displayed in the bracket on
the right of the Solid Bodies folder. You can click the (+) sign on the left of the Solid Bodies
folder to expand the folder. To collapse the folder back, click the (-) sign. Figure 5-34 shows
the expanded Solid Bodies folder with two bodies.

Figure 5-35 displays a sketch created on the sketching plane at an offset distance from the
right planar face of the model. Figure 5-36 displays the feature created by extruding the
sketch using the Through All option.

Up To Next
The Up To Next option is used to extrude the sketch from the sketching plane to the next
surface that intersects the feature. To create an extruded feature using the Up To Next option,
you must have a base feature. After creating a base feature, create a sketch by selecting or
creating a sketching plane. Invoke the Extrude PropertyManager; the preview of the base

Figure 5-34  The Feature Manager Design
Tree displaying expanded Solid Bodies folder

Tip. It is recommended that while creating additional features after the base feature,
always select the Merge results check box in the Feature PropertyManager.

The feature created from a multiple disjoint closed contours results in creation of
disjoint bodies.
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feature is displayed with default options. Select the Up To Next option from the End
Condition drop-down list. You can also reverse the direction  of feature creation using the
Reverse Direction button. The preview of the feature will be modified and the sketch will be
displayed as extruded from the sketching plane to the next surface that intersects the feature
geometry. Figure 5-37 shows the sketch that will be extruded using the Up To Next option
and Figure 5-38 shows the resultant feature.

Up To Vertex
The Up To Vertex option is used to define the termination of the extruded feature at a
virtual plane parallel to the sketching plane and passing through the selected vertex. You can
also select a point on an edge, or vertices of a sketch. To create an extruded feature using the
Up To Vertex option create a sketch and invoke the Extrude PropertyManager. Select the
Up To Vertex option from the Extrude PropertyManager; the Vertex display area is displayed.
You can reverse the direction of the extrusion using the Reverse Direction button. You are
prompted to select a vertex. Using the left mouse button select a vertex; the default preview

Figure 5-36  Sketch extruded using the Through
All option

Figure 5-35  A sketch created at an offset dis-
tance from the right planar surface

Figure 5-38  Sketch extruded using the Up To
Next option

Figure 5-37  A sketch created on the right plane
as the sketching plane
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Figure 5-40  Sketch extruded using the Up To
Vertex option.

Figure 5-39  Sketch created on a plane created at
an offset distance and vertex to be selected

of the feature is modified and you can observe that the feature is terminated at the selected
vertex. Figure 5-39 shows a sketch created on a plane at an offset distance and Figure 5-40
shows the model in which the sketch is extruded upto the selected vertex.

Up To Surface
The Up To Surface option is used to define the termination of the extruded feature to the
selected surface. To create an extruded feature using this option, create a sketch using the
normal sketching options and then invoke the Extrude PropertyManager. Select the Up To
Surface option from the End Condition drop-down list. The preview of the extruded feature
is displayed in temporary graphics. The Face/Plane display area is displayed and you are
prompted to select a face or a surface. Using the left mouse button select a surface up to
which you want to extrude the feature. Figure 5-41 shows the sketch created at an offset
distance and the surface to be selected. Figure 5-42 shows the sketch being extruded up to
the selected surface.

Figure 5-42  Sketch extruded using the Up To
Surface option.

Figure 5-41  Sketch created on a plane created at
an offset distance and surface to be selected
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Offset From Surface
The Offset From Surface option is used to define the termination of the extruded feature on
a virtual surface created at an offset distance from the selected surface. To create an extruded
feature using the Offset From Surface option, create a sketch and invoke the Extrude
PropertyManager. Select the Offset From Surface option from the End Condition drop-down
list. The Face/Plane display area is displayed along with the Offset Distance spinner. You are
prompted to select a face or a surface. Select the surface and set the offset distance in the
Offset Distance spinner. You can reverse the direction of offset by selecting the Reverse
offset check box from the Direction 1 rollout. If the Translate surface check box is cleared,
the virtual surface created for the termination of the extruded feature will have a concentric
relation with the selected surface. Therefore, it reflects the true offset of the selected surface.
If the Translate surface check box is selected, the center of the virtual surface is at the offset
distance from the selected surface. Therefore, a reference surface is created to define the
termination of the extruded feature and it does not reflect the true offset of the selected
surface. Figure 5-43 shows the front view of the sketch extruded with termination at an offset
distance from the selected cylindrical surface with the Translate surface check box
cleared. Figure 5-44 shows the front view of the extruded feature with the Translate surface
check box selected.

Up To Body
The Up To Body option available in the End Condition drop-down list is used to define the
termination of the extruded feature to another body. As discussed earlier, if you clear the
Merge results check box in the Extrude PropertyManager, it results in the formation of
another body. For creating an extruded feature using the Up To Body option, invoke the
Extrude PropertyManager after creating the sketch and select the Up To Body option from
the End Condition drop-down list. The Vertex display area is displayed. Select body to
terminate the feature and choose the OK button. Figure 5-45 shows the sketch for the extruded
feature and a body up to which the sketch will be extruded. Figure 5-46 shows the sketch
extruded using the Up To Body option.

Figure 5-44  Sketch extruded using the Offset
From Surface option with Translate surface
check box selected

Figure 5-43  Sketch extruded using Offset From
Surface option with Translate surface check box
cleared
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Figure 5-46  Sketch extruded using the Up To
Body option.

Figure 5-45  Sketch to be extruded and the body
to be selected for the extrude feature

Modeling Using the Contour Selection Method
Modeling using the contour selection method allows you to use the partial sketches for creating
the features. Using this method, you can create sketches of the entire model in a single
sketching environment and then manipulate the sketches by sharing them between various
features. To understand this concept, consider the multi-featured solid model shown in
Figure 5-47.

For a multi-featured model as shown above, ideally you first need to create the sketch for the
base feature and convert that sketch into the base feature. After that, you have to create the
sketch for the second sketched feature and so on. In other words, you have to create the
sketch for each sketched feature. But using the contour selection method, you can share the
contour created using  the sketch for creating features. Figure 5-48 shows the sketch to be
created for modeling using the contour selection method.

Figure 5-47  Multi-featured solid model
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Figure 5-48  Sketch created for creating the model

After creating the entire sketch right-click in the drawing area to invoke the shortcut menu.
Choose the Contour Selection Tool option from the shortcut menu. The select cursor is
replaced by the contour selection cursor and contour selection confirmation corner is
displayed. Using the left mouse button select the outer contour of the left larger circle using
the contour selection cursor as shown in Figure 5-49.

Figure 5-49  Contour selected for creating the extruded feature
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Now, invoke the Extrude PropertyManager and extrude the selected contour using the Mid
Plane option as shown in Figure 5-50.

Now, right-click in the drawing area and choose the Contour Selection Tool option from the
shortcut menu. Using the contour selection cursor select any entity in the sketch and then
select the middle contour of the sketch as shown in Figure 5-51. Invoke the Extrude
PropertyManager and extrude the selected contour using the mid plane option. Again, invoke
the contour selection tool and select an entity in the sketch. Next, select the outer contour of
the right circle and extrude the same using the mid plane option.

As the sketches are displayed in the model, you need to hide them. Click the +sign to expand
any of the extruded features. Select the sketch icon and right click to invoke the shortcut

Tip. When you move the contour selection cursor in the sketch, the areas where the
contour selection is possible are dynamically highlighted in pink color. When you
select a specific area using this cursor, the selected contour is displayed in yellow
color.

Figure 5-50  Isometric view of the feature created by extruding the
selected contour

Tip. When you select the contour using the contour selection tool and invoke the
Extrude PropertyManager, you can observe the name of the selected contour in
the display area of the Contour Selection rollout.

You can select the contours for all the sketched features such as revolve, cut, sweep,
loft, and so on.

You can also select the single sketched entity from sketch using the contour selection
tool instead of selecting the contour for creating the sketched features.
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Figure 5-51  Contour selected for creating second feature.

Figure 5-52  Final model.

menu. Choose the Hide Sketch option. The final model after creating all the features is
shown in Figure 5-52.

If you click the +sign to expand the extruded feature in the FeatureManager Design Tree
you will notice that instead of showing a sketch it will show you a contour selected sketch
symbol as shown in Figure 5-53.
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Figure 5-53  The FeatureManager Design Tree

CREATING CUT FEATURES
The cut is a material removal process. You can define a cut feature by extruding a sketch,
revolving a sketch, sweeping a section along a path, lofting sections, or using a surface. You
will learn more about sweep, loft, and surface in later chapters. The cut feature can be created
only if a base feature exists. The cut operation using the extrude and revolve feature is discussed
next.

Extruded Cut

To create an extruded cut feature, create a sketch for the cut feature and then choose
the Extruded Cut button from the Features toolbar. You can also choose Insert >
Cut > Extrude from the menu bar to invoke the Cut-Extrude PropertyManager. As

soon as you invoke this PropertyManager, the preview of the cut feature with default options
is displayed in the drawing area. The Cut-Extrude PropertyManager is shown in Figure 5-54.

Figure 5-55 shows the preview of the cut feature when you invoke the Cut-Extrude
PropertyManager after creating a sketch for the cut feature. The material to be removed is

Toolbar: Features> Extruded Cut
Menu: Insert > Cut > Extrude

c05-solidworks-2003.p65 5/12/2003, 10:14 AM24



Creating Reference Geometries       5-25

Figure 5-54  The Cut-Extrude PropertyManager

displayed in temporary graphics. Figure 5-56 shows the model after adding the cut feature.
The various options available in the Cut-Extrude PropertyManager are discussed next.

Direction 1
The Direction 1 rollout available in the Extrude-Cut PropertyManager is used to define the
termination of the extrude in the first direction. The various options available in the Direction 1
rollout are discussed next.

Figure 5-55  The preview of the cut feature
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End Condition
The End Condition drop-down list available in the Direction 1 rollout is used to specify
the type of termination option available. The feature termination options available in
this drop-down list are Blind, Through All, Up To Next, Up To Vertex, Up To Surface,
and Mid Plane. These option are the same as those discussed for boss/base options. By
default, the Blind option is selected in the End Condition drop-down list. Therefore,
the Distance spinner is displayed to specify the depth. If you choose the Through All or
the Through Next options, the spinner will not be displayed. The type of spinner or the
display area depend on the option selected from the End Condition drop-down list. The
Reverse Direction button is used to reverse the direction of feature creation. If you
choose the Mid Plane option from the End Condition drop-down list, the Reverse
Direction button is not available.

Flip Side to Cut
The Flip side to cut check box is selected to define the side of material removal. By
default, the Flip side to cut check box is cleared. Therefore, the material will be removed
from inside the profile of the sketch drawn for the cut feature. If you select this check
box, the material will be removed from outside the profile of the sketch. Figure 5-57
shows a cut feature with Flip side to cut check box cleared and Figure 5-58 shows a cut
feature with Flip side to cut check box selected.

Draft On/Off
The Draft On/Off button available in the Direction 1 rollout of the Cut-Extrude
PropertyManager is used to apply the draft angle to the extruded cut feature. The Draft

Tip. You can flip the direction of material removal by clicking the arrow available
on the sketch while creating the cut feature.

Figure 5-56  Cut feature added to the model
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Figure 5-57  Cut feature with Flip side to
cut check box cleared

Figure 5-58  Cut feature with Flip side to cut
check box selected

Figure 5-59  Cut feature with Draft outward
check box cleared

Figure 5-60  Cut feature with Draft outward
check box selected

Angle spinner available on the right of the Draft On/Off button is used to set the value of
the draft angle. By default, the Draft outward check box is cleared. Therefore, the draft
is created inwards with respect to the direction of feature creation. If you select this check
box, the draft added to the cut feature will be created outwards with respect to the direction
of feature creation. Figure 5-59 shows the draft added to the cut feature with the Draft
outward check box cleared and Figure 5-60 shows the draft added to the cut feature with
the Draft outward check box selected.

The Direction 2 rollout is used to specify the termination of feature creation in the second
direction. The options available in the Direction 2 rollout are the same as those discussed for
the Direction 1 rollout. The Selected Contour rollout is used to add the feature to the selected
contours.
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Thin Feature
The Thin Feature rollout is used to create a thin cut feature. When you create a cut feature,
you have to apply the thickness to the sketch in addition to the end condition. This rollout is
used to specify the parameters to create the thin feature. To create a thin cut invoke the cut
tool after creating the sketch and specify the end conditions in the Direction 1 and Direction
2 rollouts. Now, select the check box available in the Thin Feature rollout to activate the
Thin Feature rollout. The Thin Feature rollout is shown in Figure 5-61. The options available
in this rollout are the same as those discussed for the thin boss feature.

Handling Multiple Bodies in Cut Feature
While creating the cut feature, sometimes because of geometric conditions, feature termination,
or end conditions the cut feature results in the creation of multiple bodies. Figure 5-62 shows
a sketch created on the top planar surface of the base feature to create a cut feature. Figure 5-63
shows the cut feature created with the end condition as Through All. Using this type of
sketch and end condition, if you choose OK from the Extrude-Cut PropertyManager the
Bodies to Keep dialog is displayed. As multiple bodies are created while applying the cut
feature, this dialog box is used to define which body do we want to keep.

Figure 5-62  Sketch created for the cut feature. Figure 5-63  Cut feature is applied to the sketch
with end condition as Through All

Figure 5-61  The Thin Feature rollout

Tip. The sketch used for the cut feature can be a closed loop or an open sketch.
Note that if the sketch is an open sketch, the sketch should completely divide the
model in two or more than two parts.
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Figure 5-65  The Bodies to Keep dialog box with
the Selected bodies option selected

The Bodies to Keep dialog box is displayed in Figure 5-64. As the body is displayed in
temporary graphics, when you invoke this dialog box, the edges of the model are displayed
in yellow color.

By default, the All Bodies radio button is selected. Therefore, if you choose OK from this
dialog box, all the bodies created after the cut feature will remain in the model. If you want
the cut feature to consume any of the body, select the Selected bodies radio button from the
Bodies to Keep dialog box. When you select the Selected bodies radio button, a selection
and display area will be displayed as shown in Figure 5-65. You can select the check box
provided on the left of the name of the body to keep that body. The selected body is displayed
in green in temporary graphics. Select the bodies to keep and choose the OK button from
the Bodies to Keep  dialog box. Figure 5-66 shows a sketch created for the cut feature using
the thin feature. Figure 5-67 shows the cut feature created using the thin option and the All
bodies option selected from the Bodies to Keep dialog box.

IMPORTANCE OF THE FEATURE SCOPE
As discussed earlier, in SolidWorks you can create different disjoint bodies in a single part
file. After creating two or more than two disjoint bodies, when you create another feature, a
Feature Scope rollout is displayed in the PropertyManager. This rollout is used to define the
bodies that will be affected by the creation of the feature. The feature scope option is used
with the following features:

Figure 5-64  The Bodies to Keep dialog box
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1. Extrude boss and cut
2. Revolve boss and cut
3. Sweep boss and cut
4. Loft boss and cut
5. Boss cut and thicken
6. Surface cut
7. Cavity

In the Feature Scope rollout, the Selected bodies radio button and the Auto-select check
box are selected by default. With the Auto-select check box selected, all the disjoint bodies
are selected and are affected by the feature creation. If you clear the Auto-select check box,
a selection display area is invoked. You can select the bodies that you want to be affected. The
name of the selected body is displayed in the display area. If you select the All bodies radio
button then all the bodies available in the part file are selected and will be affected by the
creation of the feature.

TUTORIALS

Tutorial 1
In this tutorial you will create the model shown in Figure 5-68. You will create the model by
drawing the sketch of the front view of the model and then select the contours to extrude
them. As a result, in this tutorial you will learn the procedure of modeling using the contours
selection method. The dimensions of the model are shown in Figure 5-69.

   ( Expected time: 30 min)

It is clear from the figures that the given model is a multifeature model. It consists of various
extrude features; therefore, all these features are sketched features. You first need to draw
the sketch for each feature and then convert that sketch into the feature. In conventional
methods you have to create a separate sketch for each sketched feature. But in this tutorial,
you will use the contour selection technique. Using this method you have to create only one

Figure 5-66  Sketch to create a cut feature
using the thin option

Figure 5-67  A thin cut feature created with the
All bodies option selected
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sketch and you will select the contours and share the same sketch for creating all the features.
The steps to be followed to complete this tutorial are given next:

a. Create the sketch on the default plane and apply the required relations and dimensions,
refer to Figure 5-70.

Figure 5-69  Dimensions and views for Tutorial 1

Figure 5-68  Solid model for Tutorial 1
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b. Invoke the extrude option and extrude the selected contour, refer to Figures 5-71 and 5-72.
c. Select the second set of contour and extrude it to the required distance, refer to

Figures 5-73 and 5-74.
d. Select the third set of contour and extrude it to the required distance, refer to Figures 5-75 and 5-76.
e. Save the file and then close the file.

Creating the Sketch of the Model
1. Start SolidWorks and then open a new part file from the Template tab of the New

SolidWorks Document dialog box.

As discussed earlier, you need to choose the Sketch button from the Sketch toolbar after
opening a new part file to start sketching. You will sketch on the front plane because the
front plane is selected by default. In this tutorial you will have to create the sketch on the
front plane.

2. Draw the sketch of the front view of the model using the automatic mirroring option to
capture the design intent of the model.

3. Add the required relations and dimensions to the sketch as shown in Figure 5-70.

Selecting and Extruding the Contours of the Sketch
As discussed earlier, in this tutorial you will use the contour selection method to create the
model. Therefore, first you need to select one of the contours from the given sketch and
extrude it. For a better representation of the sketch, you will also orient the sketch to isometric view.

1. Choose the Isometric button from the Standard Views toolbar to orient the
sketch in the isometric view.

2. Right-click in the drawing area to invoke the shortcut menu. Now, choose the Contour

Figure 5-70  Fully defined sketch for creating the model
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Figure 5-71  Lower rectangle selected as a contour

Select Tool option from the shortcut menu. The select cursor will be replaced by the
contour selection cursor and selection confirmation corner is displayed.

3. Move the cursor to the lower rectangle of the sketch. When you move the cursor to the
lower rectangle of the sketch, the area of rectangle will be highlighted in pink. This
indicates that this rectangle is a closed profile.

4. Now, select the lower rectangle. The selected area is displayed in yellow. Right-click or
choose OK from the contour selection confirmation corner. You can also right-click
immediately after selecting the contour to confirm the selection and choose the End
Select Contours option from the shortcut menu. Figure 5-71 shows the lower rectangle
selected using the contour selection tool.

5. Choose the Extruded Boss/Base button from the Features toolbar. The
Extrude PropertyManager is invoked and the preview of the base feature is
displayed in the drawing area in temporary graphics.

The name of the selected contour is displayed in the display area of the Selected Contours
rollout.

6. Right-click in the drawing area and choose the Mid Plane option from the shortcut
menu. The preview of the feature is modified dynamically when you choose the Mid
Plane option.

7. Set the value of the Depth spinner to 52 and choose OK button from the Extrude
PropertyManager.

The base feature of the model by extruding the selected contour is shown in Figure 5-72.
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8. Right-click in the drawing area and choose the Contour Select Tool option from the
shortcut menu.

The select cursor is replaced by the contour selection cursor.

9. Using the contour selection cursor select any entity of the sketch to invoke the selection
mode of the sketch.

10. Using the left mouse button select the middle contour of the sketch. The selected region
will be displayed yellow in color. Right-click in the drawing area to exit the contour
selection process.

The selected middle contour is shown in Figure 5-73.

11. Choose the Extrude button from the Features toolbar to invoke the Extrude
PropertyManager.

12. Right-click in the drawing area and choose the Mid Plane option from the shortcut
menu.

13. Set the value of the Depth spinner to 40 and choose the OK button from the Extrude
PropertyManager.

The feature created by selecting the middle contour is shown in Figure 5-74.

14. Now, again invoke the Contour Select Tool and select a sketch entity. Next, select the
right contour of the sketch. Press and hold down the CTRL key and select the left contour
of the sketch.

Figure 5-72  Base feature of the model
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Figure 5-74  Second feature created by extruding the middle contour

The two selected contours are shown in Figure 5-75.

15. Invoke the Extrude PropertyManager. Right-click and choose the Mid Plane option
from the shortcut menu.

16. Set the value of the spinner to 8 and choose the OK button from the Extrude
PropertyManager.

Figure 5-73  Middle contour is selected using the contour selection tool
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The model is completed. But, the sketch is also displayed in the model. Therefore, you
need to hide the sketch.

17. Move the cursor to any of the sketched entity and when the entity turns red in color,
select the entity. The selected sketched entity will be displayed in green. Now, right-click
and choose the Hide Sketch option from the shortcut menu.

The final model with hidden sketch is shown in Figure 5-76. The FeatureManager Design
Tree of the model is shown in Figure 5-77.

Saving the Model
Next, you need to save the model.

1. Choose the Save button from the Standard toolbar and save the model with the
name given below:

\My Documents\SolidWorks\c05\c05-tut01.SLDPRT.

2. Choose File > Close from the menu bar to close the file.

Figure 5-75  The right and the left contours selected using the contour
selection tool
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Tutorial 2
In this tutorial you will create a model shown in Figure 5-78. You will use a combination of the
conventional model method and the contour selection modeling methods to create this model.
The dimensions of the model are given in Figure 5-79.    (Expected time: 30 min.)

The steps that will be used to complete the model are discussed next:

a. Create the sketch of the front view of the model, refer to Figure 5-80.
b. Extrude the selected contours, refer to Figures 5-81 through 5-82.
c. Add a cut feature to the model by creating the sketch on the left planar surface, refer to

Figures 5-84 and 5-85.
d. Create four holes using the cut feature on the top face of the base feature, refer to

Figures 5-86 and 5-87.

Figure 5-76  Final solid model

Figure 5-77  The FeatureManager Design Tree
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Figure 5-79  Drawing views of the solid model

Figure 5-78  Solid model for Tutorial 2
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Creating the Sketch for Contour Selection Modeling
You need to create the sketch by referring the front view of the model. The contours will be
selected from this sketch and the selected contour will be extruded.

1. Draw the sketch of the front view using the standard sketching tools.

2. Apply the required relations and dimensions to fully define the sketch. The fully defined
sketch is shown in Figure  5-80.

Orient the view to isometric view because it will help you in the selection of contours.

3. Choose the Isometric button from the Standard Views toolbar to orient the view
to isometric view.

4. Right-click and choose the Contour Select Tool option from the shortcut menu. The
select cursor is replaced by the contour selection cursor.

5. Using the contour selection cursor select the area enclosed by the lower rectangle as
shown in Figure 5-81.

6. Choose the Extruded Boss/Base button from the Features toolbar to invoke the
Extrude PropertyManager.

7. Set the value of the Depth spinner to 86 and choose the OK button from the Extrude
PropertyManager.

The base feature created after extruding the selected contour is shown in Figure 5-82.

Figure 5-80  Fully defined sketch
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8. Using the contour selection tool and the extrude tool create the other features by extruding
the selected contours and then hide the sketch. The model created after extruding all
the contours is shown in Figure 5-83.

Creating the Recess at the Base of the Model
After creating the extruded features of the model, you have to create the recess provided at
the base of the model. The recess will be created by extruding a sketch using the cut option
created at the right planar face of the model.

Figure 5-82  Base feature created after extruding the selected contour

Figure 5-81  Lower rectangle selected as contour
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Figure 5-83  Model created after extruding the selected contour

1. Select the right planar face of the base feature as the sketching plane. The selected face
will be displayed in green color.

2. Right-click in the drawing area and choose the Insert Sketch option from the shortcut
menu to invoke the sketching environment.

Now you need to orient the view such the selected face is normal to your eye view.

3. Choose the Normal To button from the Standard Views toolbar to orient the
selected face normal to the eye view.

4. Using the standard sketching tools create the sketch for the recess and apply the required
relations and dimensions to the sketch. The fully defined sketch for the cut feature is
shown in Figure 5-84.

5. Choose the Extruded Cut button from the Features toolbar to invoke the
Cut-Extrude PropertyManager.

The preview of the cut feature will be displayed in the drawing area in temporary graphics.

6. Right-click in the drawing area and choose the Through All option from the shortcut
menu.

7. Choose the OK button from the Cut-Extrude PropertyManager to complete the feature
creation.

The model after creating the cut feature is shown in Figure 5-85.
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Creating the Holes
After creating the recess provided at the bottom of the base, you need to create the holes on
the base of the model. You will create the sketch of the hole feature on the top planar face of
the base feature of the model. For creating the sketch of the holes you will first draw a circle
and then using the Linear Sketch Step and Repeat option create the remaining circles. After
that use the cut option to complete the hole feature.

1. Select the top planar face of the base feature as the sketching plane. Right-click and
choose the Insert Sketch option from the shortcut menu.

Figure 5-84  Sketch for the cut feature

Figure 5-85  Cut feature added to the model
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Figure 5-86  Holes sketched for the cut feature

2. Click anywhere in the drawing area to exit the selection mode.

3. Choose the Normal To button from the Standard Views toolbar to orient the
view normal to the eye view.

4. Using the standard sketching tools create a circle and then using the Linear Sketch Step
and Repeat create a pattern of the remaining circles.

5. Apply the required relations and dimensions to fully define the sketch. You may need to
apply horizontal relation between the centers of the top two circles to fully define it.

The fully defined sketch is shown in Figure 5-86.

6. Choose the Extruded Cut button from the Features toolbar to invoke the
Cut-Extrude PropertyManager.

7. Right-click in the drawing area and choose the Through All option from the shortcut
menu.

8. Choose the OK button from the Cut-Extrude PropertyManager.

The final model is shown in Figure 5-87 and the FeatureManager Design Tree of the
model is shown in Figure 5-88.
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Figure 5-88 The FeatureManager Design

Figure 5-87  Final solid model

Saving the Model
Next, you need to save the model.

1. Choose the Save button from the Standard toolbar and save the model with the
name given below:

\My Documents\SolidWorks\c05\c05-tut02.SLDPRT.

2. Choose File > Close from the menu bar to close the file.
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Tutorial 3
In this tutorial you will create the model shown in Figure 5-89. The dimensions of the model
are  given in Figure 5-90.   (Expected Time: 30 min)

The steps that will be followed to complete this tutorial are discussed next:

a. Create the base feature by extruding the sketch created on the front plane, refer to
Figures 5-91 and 5-92.

b. Extrude the sketch created on the top plane to create a cut feature, refer to
Figures 5-93 and 5-94.

c. Create a plane at an offset distance of 150 from the top plane, refer to Figure 5-95.
d. Create the sketch on the newly created plane and extrude it to a selected surface, refer to

Figures 5-96 and 5-97.
e. Create a contour bore using the cut revolve option, refer Figures 5-98 and 5-99.
f. Create the holes using the cut feature, refer Figure 5-100 and 5-101.

Creating the Base Feature
It is evident from the model that the base of the model comprises complex geometry.
Therefore, you need to create the base feature and then apply the cut feature to the base of
the model to get the desired shape. You will create the base feature on the Front plane as
the sketching plane. After creating the sketch, you will extrude the sketch using the mid
plane option to complete feature creation.

1. Open a new SolidWorks document in the part mode and invoke the sketching environment
to draw the sketch for the base feature.

2. Using the standard sketching tools create the sketch of the base feature and then apply
the required relations and dimensions to the sketch as shown in Figure 5-91.

Figure 5-89  Solid model for Tutorial 3
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Figure 5-91  Sketch of the base feature

Figure 5-90  Top view, front section view, and right section view of the model

c05-solidworks-2003.p65 5/12/2003, 10:14 AM46



Creating Reference Geometries       5-47

Figure 5-92  Base feature of the solid model

3. Choose the Extruded Boss/Base button from the Features toolbar to invoke the
Extrude PropertyManager.

4. Right-click in the drawing area and choose the Mid Plane option from the shortcut menu.

5. Set the value of the Depth spinner to 150 and choose the OK button from the Extrude
PropertyManager.

The isometric view of the base feature of the model is shown in Figure 5-92.

Creating the Cut Feature
Now, you need to create a sketch on the top plane and then you will create a cut feature using
that sketch. After creating this feature you will be able to get the base of the model.

1. Select the Top plane from the FeatureManager Design Tree and invoke the sketching
environment.

2. Create the sketch for the cut feature using the standard sketching tools and then apply
the required relations and dimensions to the sketch as shown in Figure 5-93.

Note
To change the radial dimension to the diametrical dimension, select the dimension and invoke
the shortcut menu. Choose the Properties option from the shortcut menu to display the Dimension
Properties dialog box. Select the Diameter dimension check box from this dialog box. Choose
the OK button from the Dimension Properties dialog box.

To change the diameter dimension to the radial dimension, invoke the Dimension Properties
dialog box and clear the Diameter dimension check box and choose the OK button from the
dialog box.
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Figure 5-93  Sketch for the cut feature

3. Choose the Extruded Cut button from the Features toolbar to invoke the
Cut-Extrude PropertyManager.

Since the preview of the cut feature is not displayed in the current view, therefore, you
need to orient the model in the isometric view to preview the cut feature.

4. Choose the Isometric button from the View toolbar to orient the model in the
isometric view.

It is evident from the preview of the cut feature that the direction of feature creation is
opposite to the required direction. Therefore, you need to change the direction of feature
creation.

5. Choose the Reverse Direction button provided at the left of the End Condition drop-down
list in the Cut-Extrude PropertyManager.

You will also observe that direction of material removal is not in the required direction.
Therefore, you will have to flip the direction of material removal.

6. Select the Flip side to cut check box. You will observe that the direction of material
removal is also changed in the preview.

7. Right-click in the drawing area and choose the Through All option from the shortcut
menu and choose the OK button from the Cut-Extrude PropertyManager.

The model after creating the base feature is shown in Figure 5-94.

Creating a Plane at an Offset Distance
After creating the base of the model you will create a plane at an offset distance from the top
plane. This newly created plane will be used as a sketching plane for the next feature.
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1. Choose the Plane button from the Reference Geometry toolbar to invoke the
Plane PropertyManager. The Plane PropertyManager is displayed on the left
of the drawing area.

2. Choose the Offset Distance button from the Plane PropertyManager. The Distance
spinner, Reverse Direction check box, and Number of Planes to Create spinner are
displayed in the Plane PropertyManager.

Since the planes are not displayed in the drawing area, therefore, you will invoke the
FeatureManager Design Tree flyout to select the Top plane from the same.

3. Move the cursor to the top of the Plane PropertyManager where the name of the
PropertyManager is displayed. The tool tip will show you the name of that area as Show
FeatureManager.

4. Use the left mouse button at that location to invoke the FeatureManager Design Tree
flyout.

5. Select the Top plane from the FeatureManager Design Tree.

When you choose the Top plane, the preview of the newly created plane at an offset
distance using a default value is displayed in the drawing area.

6. Set the value of the Distance spinner to 150 and choose the OK button from the Plane
PropertyManager.

The newly created plane is shown in Figure 5-95.

Figure 5-94  Cut feature added to the base feature
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Figure 5-95  Plane created at an offset distance from the top plane

Creating the Extruded Feature
After creating the plane at an offset distance from the top plane, you will create the next
feature, which is an extruded feature. The sketch of the next feature is created on the newly
created plane and the sketch is extruded upto a selected surface.

Since the newly created plane is selected, therefore, you do not need to select the plane.

1. Invoke the sketching environment and click anywhere in the drawing area to remove the
plane from the selection set.

2. Choose the Normal To button from the Standard Views toolbar to orient the
selected plane normal to the eye view.

The model will be oriented such that the sketch plane is oriented normal to the eye view.

4. Draw the sketch of the circle and apply the required relations to the sketch as shown in
Figure 5-96.

5. Choose the Extruded Boss/Base button from the Features toolbar. The preview
of the feature is displayed in the drawing area.

You need to orient the model in the isometric view because the preview of feature creation
is not clear in the current view.

6. Orient the model in the isometric view.

You will observe from the preview that the direction of feature creation is opposite to the
required direction. Therefore, you need to change the direction of feature creation.
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7. Choose the Reverse Direction button provided at the left of the End Condition drop-down
list to reverse the direction of feature creation.

You will observe that the preview of the feature is also changed when you reverse the
direction of feature creation.

8. Right-click in the drawing area and choose the Up To Surface button from the shortcut
menu. You are prompted to select a face or a surface to complete the specification of end
condition in Direction 1.

The Face/Plane display area is displayed under the End Condition drop-down list.

9. Select the upper curved surface of the model using the left mouse button. You will observe
that the preview shows the feature extruded upto the selected surface.

10. Choose the OK button from the Extrude PropertyManager or right-click to choose the
OK option.

Since the plane is displayed in the drawing area, you need to turn its display off.

11. Select Plane 1 from the FeatureManager Design Tree or from the drawing area and
invoke the shortcut menu. Choose the Hide option from the shortcut menu.

The model created after creating the extruded feature is shown in Figure 5-97.

Creating the Counterbore Hole
Next, you have to create the counterbore hole by revolving a sketch created on the front
plane using the cut option.

Figure 5-96  Sketch created on the newly created plane
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Figure 5-98  Fully defined sketch for the contour bore

Figure 5-97  Sketch extruded upto a selected surface

1. Invoke the sketching environment by selecting the Front plane as the sketching plane
and orient the front plane normal to the eye view.

2. Create the sketch of the counterbore hole using the standard sketching tools. As discussed
earlier the sketch will be revolved along a centerline using the cut option. Therefore,
after creating the sketch and applying the required relations you will dimension the
sketch using the diametrical dimensioning along the centerline.

The sketch after applying the required relations and dimensions is shown in Figure 5-98.
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3. Choose the Revolved Cut button from the Features toolbar to display the
Cut-Revolve PropertyManager. The preview of the cut feature is displayed in
the drawing area in temporary graphics. The value of the angle in the Angle
spinner is set to 360 by default. Therefore, you do not need to set the value of the Angle
spinner.

4. Choose the OK button from the Cut-Revolve PropertyManager.

Figure 5-99 shows the model after creating the revolve cut feature.

Creating the Holes
After creating all the features, you will create the holes using the cut feature to complete the
model. The sketch for the cut feature will be created using the top planar surface of the base
feature as the sketching plane.

1. Select the top planar surface of the base feature and invoke the sketching environment.
Orient the model so that the selected face of the model is oriented normal to the eye
view.

2. Create the sketch using the standard sketching tools and apply the required relations
and dimensions as shown in Figure 5-100.

3. Choose the Extruded Cut button from the Features toolbar to invoke the
Cut-Extrude PropertyManager.

4. Right-click and choose the Through All option from the shortcut menu and choose the
OK button from the Cut-Extrude PropertyManager or invoke the shortcut menu and
choose the Through All option from the shortcut menu.

Figure 5-99  Cut feature added to the model
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Figure 5-100  Fully defined sketch for cut feature

Orient the model in the isometric view. The final model is shown in Figure 5-101. The
FeatureManager Design Tree of the model is shown in Figure 5-102.

Saving the Model
Next, you need to save the model.

1. Choose the Save button from the Standard toolbar and save the model with the
name given below:

Figure 5-101  Final model
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\My Documents\SolidWorks\c05\c05-tut03.SLDPRT.

2. Choose File > Close from the menu bar to close the file.

SELF-EVALUATION TEST
Answer the following questions and then compare your answers with the answers given at
the end of this chapter.

1. When you create a sketch for the first time in the sketching environment, the sketch is
created on the default plane, which is Front plane. (T/F)

2. When you create a new SolidWorks part document, SolidWorks provides you with two
default planes. (T/F)

3. You can choose the Plane button from the Features toolbar to invoke the Plane
PropertyManager. (T/F)

4. You cannot create a plane at an offset distance by dynamically dragging. (T/F)

5. When you create a circular feature a temporary axis is automatically created. (T/F)

6. The ___________ option is used to extrude a sketch from the sketching plane to the next
surface that intersects the feature.

7. The __________ option available in the End Condition drop-down list is used to define
the termination of the extruded feature upto another body.

8. The __________ check box is used to merge the newly created body with the parent body.

Figure 5-102  FeatureManager Design Tree of the model
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9. Using the __________ option you can create a reference axis that passes through the
center point of a cylindrical or a conical surface.

10. Sometimes multiple bodies are created while applying the cut feature; therefore, the
__________ dialog box is displayed that allows you to define which body do we want to keep.

REVIEW QUESTIONS
Answer the following questions:

1. If the ___________ check box is cleared, then the virtual surface created for the termination
of the extruded feature will have a concentric relation with the selected surface.

2. The __________ option is selected from the shortcut menu to select the contours.

3. The __________ option is available in the End condition drop-down list only after you
create the base feature.

4. The __________ check box is used to define the side of material removal.

5. The __________ check box is used to create an outward draft in a cut feature.

6. Which check box is selected while creating any other feature in a single body modeling?

(a) Combine results (b) Fix bodies
(c) Merge results (d) Union results

7. Which button is used to add a draft angle to a cut feature?

(a) Add Draft (b) Create Draft
(c) Draft On/Off (c) None of these

8. Which PropertyManager is invoked to create a cut feature by extruding a sketch?

(a) Extruded Cut (b) Cut-Extrude
(c) Extrude-Cut (d) Cut

9. The option used to define the termination of feature creation at an offset distance to a
selected surface is

(a) Distance To Surface (b) Normal From Surface
(c) Distance From Surface (d) Offset From Surface

10. The option used to define the termination of feature creation to the selected surface is

(a) To Surface (b) Selected Surface
(c) Up To Surface (d) None of these
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EXERCISES

Exercise 1
Create the model shown in Figure 5-103 . The dimensions of the model are given in
Figure 5-104.     (Expected time: 30 min)

Figure 5-103  Model for Exercise 1
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Figure 5-104  Dimensions of the model for Exercise 1

Exercise 2
Create the model shown in Figure 5-105 . The dimensions of the model are given in
Figure 5-106.     (Expected time: 30 min)
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Figure 5-106  Dimensions for Tutorial 2

Figure 5-105  Model for Exercise 2
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Answers to Self-Evaluation Test
1. T, 2. F, 3. T, 4. F, 5. T, 6. Up To Next, 7. Up To Body, 8. Merge results, 9.
Cylindrical/Conical Surface, 10. Bodies to Keep
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